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[ Package Explorer £3 = § ¥ =0 \J] ExampleThing.java 83 ¥ metadata.xm| %5+ build-extension.xml - g 0= Outline £3 B 1% ] X o w ¥ =0
v (= Example Extension 18 . ' 4 com.example.things
> B src 19 public'class ExampleThlng extends 'Thlng { v® ExampleThing
> =4 JRE System Library [JavaSE-1.8] hlﬁ private static final long serialVersionUID = -734037441678274101L; 5F serialVersionUID - tong
> I\ Referenced Libraries 22 protected Logger logger = LogUtilities.getInstance().getApplicationlLogger(this.getClass()); logger : Logger
P (= configfiles 23 <» ainitializeThing() : void
b (=lib 24 @0verride @ GetEntityCounts() : InfoTable
@build-extension.xml a5 protected void initializeThing() throws Exception {

26 super.initializeThing();

27 // Custom initialization

28 }

30 @ThingworxServiceDefinition(

31 name = "GetEntityCounts",

32 description = "Returns an InfoTable of entity counts sorted in descending order..")

33 @ThingworxServiceResult(

34 name = "result",

35 description = "An InfoTable (EntityCount) of entity counts.",

36 baseType = "INFOTABLE",

37 aspects = { "dataShape:EntityCount" })

38 public InfoTable GetEntityCounts() throws Exception {

39 InfoTable result = new InfoTable();

49

41 String[] entityTypes = {

42 "Things", "ThingTemplates", "ThingShapes", "DataShapes", "Networks",

43 "ModelTags", "Mashups", "Dashboards", "Menus", "MediaEntities",

44 "StyleDefinitions", "StateDefinitions", "DataTags", "PersistenceProviders",

45 "Users", "Groups", "Organizations", "ApplicationKeys", "DirectoryServices",

46 "LocalizationTables", "Resources", "Subsystems", "Logs"

47 I

48

49 try {

50 InfoTable entityCounts = InfoTableInstanceFactory.createInfoTableFromDataShape("name", "EntityCount"); // name and count

51

52 PlatformSubsystem platformSubsystem = (PlatformSubsystem) SubsystemManager.getInstance().getEntity("PlatformSubsystem");

53

54 // Get entity counts

55 for (int i1 = @; 1 <= entityTypes.length; i++) {

56 InfoTable entityCount = platformSubsystem.GetEntityCount(entityTypes[i], null);

57

5& ValueCollection value = new ValueCollection();

59 value.put("name", new StringPrimitive(entityCount.getRow(@).getValue("name").toString()));

6@ value.put("count", new IntegerPrimitive(Integer.parseInt(entityCount.getRow(@).getValue("count").toString())));

61 entityCounts.addRow(value);

b }

63

64 // Sort entityCounts in descending order

65 InfoTableFunctions infoTableFunctions = (InfoTableFunctions) ResourceManager.getInstance().getEntity("InfoTableFunctions");

b6 result = infoTableFunctions.Sort(entityCounts, "count", false);

67 } catch (Exception e) {

68 logger.error("null");

b9 }'

i

71l return result;

- bl

\* Problems (@ Javadoc [, Declaration [ Console 5% <Yy = O

No consoles to display at this time.




Perspectives

| ‘ T 99 Java EE %’Java

X R\ e v=
n.example.things
| | | impleThing
A Java perspective is a collection  serialVersionUID : long
of views and an editor. ogger : Logger

nitializeThing() : void
: : : GetEntityCounts() : InfoTable
The Java perspective Is designed

for working with Java projects; the
Debug perspective Is designed
for debugging Java programs.




Package cxplorer

The Package Explorer view
shows the Java element hierarchy
of the Java project.

It provides a Java-specific view of
the resources shown in the
Navigator.
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& Package Explorer 23

v & Example Extension

|

|
|
|
|

> Fsrc
» =, JRE System Library [JavaSE-1.8]
» =, Referenced Libraries
» .~ configfiles
» =~ lib
=% | build-extension.xml|



E] ExampleThing.java &8 X metadata.xml ij;_l build-extension.xml
19 public class ExampleThing extends Thing {
20 private static final long serialVersionUID = -734037441678274101L;
21
22 protected static Logger logger = LogUtilities.getInstance().getAppli

24= @0verride

a5 protected void initializeThing() throws Exception {
26 super.initializeThing();
27 // Custom initialization

£ 8 }

30 @ThingworxServiceDefinition(

31 name = "GetEntityCounts",

32 description = "Returns an InfoTable of entity counts sorted
33 @ThingworxServiceResult(

34 name = "result"”,

35 description = "An InfoTable (EntityCount) of entity counts.'’

Editor

The Java editor provides features for editing Java code.



Outline

| Gl B 99 JavaEE

5= Outline 23 3 R W e w

++ com.example.things

'€ ExampleThing
« " serialVersionUID long

. _ _ & 9 logger : Logger
The Outline view displays an o ainitializeThing() : void

outline of the structure of the @ GetEntityCounts() : InfoTable

currently-active Java file in the
editor.
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<terminated> Example Extension build-extension.xml [Ant Build] /Library/Java/JavaVirtualMachines/jc

[mkdir] Created dir: /Users/adam/Developer/thingworx/extensions/workspace
[mkdir] Created dir: /Users/adam/Developer/thingworx/extensions/workspace
build-source:
[echo] Example_Extension: /Users/adam/Developer/thingworx/extensions/wor
[javac] Compiling 1 source file to /Users/adam/Developer/thingworx/extens
build-jars:
[echo] building thingworx-example-extension.jar to /Users/adam/Developer
[jar] Building jar: /Users/adam/Developer/thingworx/extensions/workspac
package-extension:
[zip] Building zip: /Users/adam/Developer/thingworx/extensions/workspac
build:
[echo] Building Example_Extension extension package...
BUILD SUCCESSFUL
Total time: 645 milliseconds

Console

The Console view displays a variety of console types.
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Projects

A Java project contains source code and related files
for building a Java program.

't maintains a model of its contents including
information about the type hierarchy, references and
declarations of Java elements.




Importing Projects

Choose File > Import....

218 Edit Source Refactor Navigate Sear

New &N B>
Open File...

Close ab
Close All {38

Save
@ Save As...

Save All
Revert

Move...
Rename...

Refresh
Convert Line Delimiters To >

Print...

Switch Workspace >
Restart

. Export...



Importing Projects

N EON | Import
' Select
hY
Create new projects from an archive file or directory. I E - 5 |

Select an import source:

Vv [ General
[ Archive File
4 File System
| Preferences
» (= CVS

Select Existing Projects into

» [ Git
W k » [~ Gradle
Or Space- » [ Install
» [—~Java EE
» [ Maven
. » ([ Plug-in Development
C | IC k NeXt > » [~ Remote Systems
» = Run/Debug
» [ Tasks
» [~ Team

@ BT conce




Importing Projects

® Import
Import Projects —
Select a directory to search for existing Eclipse projects. ' ,f"
-
© Select root directory:  /Users/adam/Downloads/Example Extension |4 Browse...

Select archive file:

Projects:

Choose Select root directory or
Select archive file and click the
assoclated Browse to locate the
directory or file containing the

project.

Search for nested projects
C | . k F - - h Copy projects into workspace
I C I n IS . Hide projects that already exist in the workspace

Working sets

Add project to working sets

Working sets:

@ < Back Cancel | Finish  Jg




Creating Projects

Edit Source Refactor Navigate Search Project Run Windov

Choose File > New > Java
Project.

: £ Java Project
Open File... =i Project...
Close
Close All LR
(& Class
Save & Interface
Save As... & Enum
Save All @ Annotation
Revert # Source Folder
Move... ‘l_.l Java Working Set
Rename... 'I_\.T e
| Refresh FS ML
Convert Line Delimiters To > = Untitled Text File
ET JUnit Test Case
Print... “ Task
Switch Workspace > =i Example...
Restart
™ Other... 3N
i« Import... :
i Export...
Properties

1 ExampleThing.java [Example Extensio...]
2 build-extension.xml [Example Extension]
3 metadata.xml [Example Extension/...]



Creating Projects

([ NON _ New Java Project
Create a Java Project = J
- i
Create a Java project in the workspace or in an external location. ' .'

Project name: Example Extension

Use default location

Location:
JRE
O Use an execution environment JRE: JavaSE-1.7 ﬁ
Use a project specific JRE: Java SE 7 [1.7.0_79] .-
Use default JRE (currently 'Java SE 7 [1.7.0_79]") Configure JREs...

Click Finish.

Project layout

Use project folder as root for sources and class files

O Create separate folders for sources and class files Configure default...

Working sets

Add project to working sets

<>

Working sets:

The default compiler compliance level for the current workspace is 1.8. The new project
will use a project specific compiler compliance level of 1.7.

@ Next > Cancel | Finish




Project Structure

. Navigator 23

v Example Extension

configfiles/metadata.xmi

>

ThingWorx entities

lib/
JAR libraries
src/
Java source code

build-extension.xml

Ant build file

.settings
L+ bin
configfiles
lib
src
X .classpath
X .project
% | build-extension.xm!

-



Configuring the Build Path

50 QrimE g e

Right-clic
Package

< 1

ne project in the

nlorer.

3

=3y e H G

:

4

v

i |

% Package Explorer 23

B Example Extension
> Hsrc
P =, JRE System Library [JavaSE-1.8]
V =, Referenced Libraries
» (ya thingworx-all-6.0.1-b12.jar
> (o joda-time-2.3.jar
» (aw logback-classic-1.0.13.jar
» (ms logback-core-1.0.13.jar
» (oo slf4j-api-1.7.6.jar
P = configfiles
v (= lib
£lljoda-time-2.3.jar
&1l logback-classic-1.0.13.jar
£l logback-core-1.0.13.jar
£ sIf4j-api-1.7.6.jar
£Jthingworx-all-6.0.1-b12.jar
@ build-extension.xml

o

- B E
New
Go Into

Open in New Window
Open Type Hierarchy
Show In \#EW
i=) Copy

5= Copy Qualified Name

) Paste

X Delete

Remove from Context
Build Path
Source
Refactor

X #S
X #ET

i« Import...
i Export...

«* Refresh

Close Project

Close Unrelated Projects
Assign Working Sets...

Profile As

Debug As

Run As

Validate

Restore from Local History...
StartExplorer

Team

Compare With

Configure

Properties

El ExampleThing.java

> |

F4

4

8C

sV
B>

v

v

F5

vVvVvYyy

vVvyvyy

a8l



T NG 5 0- Q00 i RiEE
& Package Explorer 23 == ¥ = 0O \J] ExampleThing.java 23
- . | L0
a"‘p'e XIS — yleThing extends Thing {
> (Zsre : final long serialVersionUID =
» =, JRE System Library [JavaSE-1.8] Go Into

V =, Referenced Libraries
» [y thingworx-all-6.0.1-b12.jar
» (oo joda-time-2.3.jar
» (ms logback-classic-1.0.13.jar
» (ma logback-core-1.0.13.jar
» (ug slf4j-api-1.7.6.jar
» (= configfiles
V[ —~lib
@joda-time-z.S.jar
;Q logback-classic-1.0.13.jar
;!L logback-core-1.0.13.jar
£ sif4j-api-1.7.6.jar
@thingworx-all-G.OJ -b12.jar
:E;lbuild-extension.xml

Build Path >

, _ jer logger = LogUtilities.getIns
Open in New Window

Open Type Hierarchy F4

Show In T W p 1 initializeThing() throws Excep
tializeThing();

B Copy 3G initialization

5= Copy Qualified Name

“ Paste 3p\/ viceDefinition(

- = "GetEntityCounts",

X Delete Lption = "Returns an InfoTable o
/iceResult(

. Remove from Context = "result",

i Link Source...

Source \ &S > & New Source Folder...
Refactor 3T >

. 2 Use as Source Folder

x1 Import... ms Add External Archives...

i Export... =\ Add Libraries...

+* Refresh F5 |

s Configure Build Path...

ClAaea Praiacnt T E—

Configuring the Build Path

Choose Build Path > Configure Build Path....



00 @ Properties for Example Extension

(%) Java Build Path

v v W
» Resource
Builders (42 Source =" Projects ‘%~ Order and Export
| '
» Java Code Style JARs and class folders on the build path:
» Java Compiler » (s joda-time-2.3.jar - Example Extension/lib Add JARS...
» Java Editor » | logback-classic-1.0.13.jar - Example Extension/lib
Javadoc Location » [us logback-core-1.0.13.jar - Example Extension/lib Add External JARs. ..
Project Facets » (w4 slf4j-api-1.7.6.jar - Example Extension/lib
Project References = S _ -api-1.1.5 'p o
Refactoring History » (s thingworx-all-6.0.1-b12.jar - Example Extension/lib Add Variable...
Run/Debug Settings » =, JRE System Library [JavaSE-1.8]
Server Add Library...
» Task Repository
Task Tags Add Class Folder...
» Validation
WikiText Add External Class Folder...
2

Configuring the

Click Add JARS... to add JA

Cancel 0K

Bulld Pa

3s to the build path.



Packages

A Java package is a mechanism
for organizing Java classes into
namespaces.

Packages correspond to the
ocation of Java source files in
the filesystem.

n a Java source file, the
nDackage of the class is specitied
using the package keyword.

=

s - g 4 y
v \ - G, v
el = T:»-J

& Package Explorer 23

v & Example Extension

com.example.things
» |J| ExampleThing.java
» =, JRE System Library [JavaSE-1.8]
» =, Referenced Libraries
» [ configfiles
» —~lib

% | build-extension.xm|




Building Projects

» B\, Hererencead Lipbraries
» |~ configfiles
» (=lib

4 build-extension.xml

New >

Open F3

Open With [

Show In \EW B>

~| Copy 3#&C

5= Copy Qualified Name

) Paste BV

X Delete 3

Remove from Context

Right-click build-extension.xml. Mark as Landmark

Build Path >

Refactor 38T >

w4 Import...

3 Export...

& Refresh F5

Assign Working Sets...

Validate

Show in Remote Systems view

Open Javadoc Wizard...

Profile As >

Debug As >

Run As >



Building Projects

Choose Run As > 1 Ant Build.

New

Open
Open With
Show In X #EW

=] Copy

5= Copy Qualified Name
1 Paste

X Delete

. Remove from Context
Mark as Landmark

Build Path
Refactor X &ET

i Import...
i Export...

+ Refresh
Assign Working Sets...

Validate

Show in Remote Systems view
Open Javadoc Wizard...

Profile As

Debug As

Replace With
StartExplorer
Team

vy

3C

eV

v

>

F5

>
>
>
>
>
>

VT U LT W W w WL

B2 0O oo

f

-

}

@ThingworxServiceDefinition(
name = "GetEntityCounts"”
description = "Returns a

@ThingworxServiceResult(
name = "result",
description = "An InfoTa

baseType = "INFOTABLE",
aspects = { "dataShape:E
public InfoTable GetEntityCounts
InfoTable result = new InfoT

String[] entityTypes = {
"Things", "ThingTemp
"ModelTags", "Mashup
"StyleDefinitions",
"Users", "Groups",
"LocalizationTables"

}s

try {
InfoTable entityCounts =

PlatformSubsystem platfo

// Get entity counts
for (int 1 = 0; i < enti
InfoTable entityCoun

ValueCollection valu
value.put("name", ne

vnliita nutlC"rcraiind" n,

1 Ant Build
% 2 Ant Build...

External Tools Configurations...



Exercise 1

. Using the provided resources, create a Java
oroject and structure it properly.

. Builld the extension.

. Import the extension.



Remote Debugging



Configuring Tomcat

Add the following options:

—-Xdebug —-Xrunjdwp:transport=dt_socket,address=8000,server=y, suspend=n

ol

Start Tomcat with the following command:

catalina jpda start



Configuring ThingWorx

Build and import the extension.
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[ Package Explorer £2

——
= ]

» &) ThingWorx Platform Extensibility

ThingWorx Platform Extensibility

New >
Go Into

Open in New Window

Open Type Hierarchy F4

Show In X#EW >
Copy #C

= Copy Qualified Name

1) Paste BV

& Delete (34

Remove from Context

Build Path >

Source &S >

Refactor T >
« Import...

g Export...

= Refresh F5

Close Project
Close Unrelated Projects
Assign Working Sets...

Profile As >
Debug As

Run As

Validate

Restore from Local History...
StartExplorer

Team

Compare With

Configure

vy

vVVvyyYy

Properties &l

T

[* Problems | @ Javadoc | [z, Declaration ) Console R

No consoles to display at this time.

onfiguring Eclip

ght-click the project in the

Package

=XPl

B v,fJava EE gﬁjJava Zf‘;Debug

= 0

SC

orer.

=

|§—]

o=
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[ Package Explorer £2

- v =
- S B

> B ThingWorx Platform Extensibility

New >
Go Into

Open in New Window

Open Type Hierarchy F4

Show In XEW >

i=| Copy #C

&= Copy Qualified Name

) Paste ®V

% Delete (3
Remove from Context

Build Path >

Source &S >

Refactor T >

= Import...

g Export...

= Refresh F5

Close Project
Close Unrelated Projects
Assign Working Sets...

Profile As »

5 1 Debug on Server O-XDR
Run As > &5 2 Java Applet ~X3#DA
Validate {3 3 Java Application ~ 3D J

Restore from Local History...

StartExplorer 2 Debug Configurations...
Team >

Compare With >

Configure »

Properties &l

|

(21 Problems | @ Javadoc | [& Declaration | & Console 52

No consoles to display at this time.

ThingWorx Platform Extensibility

=]

»:3 Java EE 3’;’ Java T’K& Debug

= O
2
El
=
=
o=
yFiy = B8

onfiguring Eclipse

Choose Debug As > Debug Configurations....



® 0 Debug Configurations

Create, manage, and run configurations

Attach to a Java virtual machine accepting debug connections

~ ey
R [H Name: ThingWorx Platform Extensibility

9 ||| 1% connect k  Source | [_] Common

Apache Tomcat

& Eclipse Application

£ 4 Eclipse Data Tools

= Generic Server

Generic Server(External Launch)

Project:

ThingWorx Platform Extensibility Browse...

Connection Type:

= HTTP Preview
| J2EE Preview Standard (Socket Attach) [V
=4 Java Applet
[J]Java Application Connection Properties:
JuJUnit
37 JUnit Plug-in Test Host: localhost
m2 Maven Build Port: 8000
4 OSGi Framework
v i+ Remote Java Application Allow termination of remote VM

~ThingWorx Platform Extensibility

> Remote JavaScript
5] Rhino JavaScript
J1y Task Context Test
3 XSL

Filter matched 19 of 19 items

Close Debuo

Configuring Eclipse

Double-click Remote Java Application.

|:.‘- ;)1



® 0 Debug Configurations

Create, manage, and run configurations

Attach to a Java virtual machine accepting debug connections

~ ey
R [H Name: ThingWorx Platform Extensibility

9 ||| 1% connect k  Source | [_] Common

Apache Tomcat

& Eclipse Application

£ 4 Eclipse Data Tools

= Generic Server

Generic Server(External Launch)

Project:

ThingWorx Platform Extensibility Browse...

Connection Type:

~| HTTP Preview
| J2EE Preview Standard (Socket Attach) [V
=4 Java Applet
7] Java Application Connection Properties:
JuJUnit
37 JUnit Plug-in Test Host: localhost
m2 Maven Build Port: 8000
4 OSGi Framework
v i+ Remote Java Application Allow termination of remote VM

®X ThingWorx Platform Extensibility

> Remote JavaScript
5] Rhino JavaScript
J1Task Context Test
3 XSL

Filter matched 19 of 19 items

Close Debuo

Configuring Eclipse

Click Debug.

()



19 tr‘y {
© Toggle Breakpoint {+38B

s = InfoTableInstanceFactory.createlInfo

Toggle Breakpoint Enablement itformSubsystem = (PlatformSubsystem) Su

Go to Annotation
StartExplorer p entityTypes.length; i++) {
ount = platformSubsystem.GetEntityCount

Add Bookmark...

ralue = new VGlUGCOllECtion();

| Add Task... new StringPrimitive(entityCount.getRow
| : : ~ , new IntegerPrimitive(Integer.parselnt
v Show Quick Diff 4Q Bw(value):
v Show Line Numbers
~ Folding >
1n descending order
Preferences. .. ifoTableFunctions = (InfoTableFunctions)

iIctions.Sort(entityCounts, "count", fals
Breakpoint Properties...

— — --aa-' T - - - ,’

[‘.' E'..‘ }

/e

Adding Breakpoints

Right-click the area to the left of the line of code.



Ev ; R, I e , CH vi B
(% Package Explorer £3 & A
- ExampleExtenson

> Hsrc

» =, JRE System Library [JavaSE-1.8]
> =\ Referenced Libraries
P (= configfiles
b = lib
;l—e]build-extension.xml

Example Extension

Ay Wy (%D

\J] ExampleThing.java £3

EI‘E_v vyT (v v

X| metadata.xml % | build-extension.xm|

"EntityCount"); // name and count

).getEntity("PlatformSubsystem");

tring()));
tValue("count").toString())));

18
19 public class ExampleThing extends Thing {
20 private static final long serialVersionUID = -734037441678274101L;
21
22 protected Logger logger = LogUtilities.getInstance().getApplicationLogger(this.getClass());
23
24 @0verride
a5 protected void initializeThing() throws Exception {
26 super.initializeThing();
27 // Custom initialization
28 }
29
30 @ThingworxServiceDefinition(
31 name = "GetEntityCounts",
32 description = "Returns an InfoTable of entity counts sorted in descending order..")
33 @ThingworxServiceResult(
34 name = "result",
35 description = "An InfoTable (EntityCount) of entity counts.",
36 baseType = "INFOTABLE",
37 aspects = { "dataShape:EntityCount” })
38 public InfoTable GetEntityCounts() throws Exception {
39 InfoTable result = new InfoTable();
49
41 String[] entityTypes = {
42 "Things", "ThingTemplates", "ThingShapes", "DataShapes", "Networks",
43 "ModelTags", "Mashups", "Dashboards", "Menus", "MediaEntities",
44 "StyleDef @ ) Confirm Perspective Switch
45 "Users",
46 "Localiza ' This kind of launch is configured to open the Debug perspective when it suspends.
47 I 2
48 o This Debug perspective is designed to support application debugging. It
49 try { incorporates views for displaying the debug stack, variables and breakpoint
850 InfoTable ent management.
:i PlatformSubsy Do you want to open this perspective now?
53
Zg ;ngE:nin?Zy Remember my decision
:E InfoTable No Yes
58 ValueColle~
59 value.put("name", ringPrimitive( Lt getRow(@).getValue("name™).toS
60 value.put("count", new IntegerPrimitive(Integer.parseInt(entityCount.getRow(@).ge
61 entityCounts.addRow(value);
62 }
b3
b4 // Sort entityCounts in descending order
b5 InfoTableFunctions infoTableFunctions = (InfoTableFunctions) ResourceManager.getInstance().getEntity("InfoTableFunctions");
66 result = infoTableFunctions.Sort(entityCounts, "count", false);
67 } catch (Exception e) {
68 logger.error("null");
69 }
784
71 return result;
= 2
|- Problems @ Javadoc [, Declaration E Console 23

No consoles to display at this time.

]

8

Bl R s e w

# com.example.things
v ExampleThing
o F serialVersionUID : long
< logger : Logger
<» ainitializeThing() : void
@ GetEntityCounts() : InfoTable

0= Outline £3

B w2

Java EE &JJava

VEE

IIlv rjv = E




w BT T O P Y : 450 Qe (=E 5 W e || B 8 uavace §'uava [$5Debug

15 Debug % | 474 Servers ¥ = O 0= variables X Breakpoints EE Y= 0O
¥ //* Daemon Thread [http-nio-8443-exec-8] (Suspended (breakpoint at line 50 in ExampleThing)) Name Value
«=owns: SecureNioChannel (id=98) P> @ this ExampleThing (id=97)
— ExampleThing.GetEntityCounts() line: 50 b O result InfoTable (id=165)
= NativeMethodAccessorimpl.invokeO(Method, Object, Object][]) line: not available [native method] b O entityTypes String[23] (id=166)

= NativeMethodAccessorimpl.invoke(Object, Object]]) line: 62

= DelegatingMethodAccessorimpl.invoke(Object, Object(]) line: 43

= Method.invoke(Object, Object...) line: 497

= ReflectionProcessor.processService(Object, ValueCollection) line: 118

= ReflectionServiceHandler.processService(IServiceProvider, ValueCollection) line: 28
= ExampleThing(Thing).processServiceRequestDirect(ServiceDefinition, ValueCollection) line: 4463
= ExampleThing(Thing).processAPIServiceRequest(String, ValueCollection) line: 4398
= Things(BaseService).handlelnvoke(HttpExecutionContext) line: 2453

= Things(BaseService).service(HttpServletRequest, HttpServietResponse) line: 303
= Things(HttpServlet).service(ServletRequest, ServietResponse) line: 729

= ApplicationFilterChain.internalDoFilter(ServletRequest, ServletResponse) line: 291
= ApplicationFilterChain.doFilter(ServletRequest, ServletResponse) line: 206

= WsFilter.doFilter(ServletRequest, ServletResponse, FilterChain) line: 52

= ApplicationFilterChain.internalDoFilter(ServletRequest, ServletResponse) line: 239
= ApplicationFilterChain.doFilter(ServletRequest, ServletResponse) line: 206

= ContentTypeFilter.doFilter(ServietRequest, ServletResponse, FilterChain) line: 75

\ 3 S
|J| ExampleThing.java 3 metadata.xml build-extension.xml - 0 0= Outline £3 %R W e x v =0

42 "Things", "ThingTemplates", "ThingShapes", "DataShapes", "Networks", 4 com.example.things

43 "ModelTags", "Mashups", "Dashboards", "Menus", "MediaEntities", v (9 ExampleThing

44 "StyleDefinitions", "Stathef?nitions", "pataTags", "Pers?stenceProviQers", :ﬁFseﬁmenﬁonLHD:Iong

45 "Users", "Groups", "Organizations", "ApplicationKeys", "DirectoryServices", loager : Loager

46 "LocalizationTables", "Resources", "Subsystems", "Logs" o 99_ ’ 99 ‘

47 }: <» ainitializeThing() : void

48 © GetEntityCounts() : InfoTable

49 try {
950 InfoTable entityCounts = InfoTableInstanceFactory.createInfoTableFromDataShape("name", "EntityCount"); // name and count

51

52 PlatformSubsystem platformSubsystem = (PlatformSubsystem) SubsystemManager.getInstance().getEntity("PlatformSubsystem");

53

54 // Get entity counts

55 for (int 1 = @; 1 <= entityTypes.length; i++) {

56 InfoTable entityCount = platformSubsystem.GetEntityCount(entityTypes[i], null);

57

58 ValueCollection value = new ValueCollection();

59 value.put("name", new StringPrimitive(entityCount.getRow(@).getValue("name").toString()));

14 value.put("count", new IntegerPrimitive(Integer.parseInt(entityCount.getRow(@).getValue("count").toString())));

71 entityCounts.addRow(value);

}

4 // Sort entityCounts in descending order

75 InfoTableFunctions infoTableFunctions = (InfoTableFunctions) ResourceManager.getInstance().getEntity("InfoTableFunctions");
b6 result = infoTableFunctions.Sort(entityCounts, "count", false);

67 } catch (Exception e) {

b& logger.error("null");

69 }

£ console 2 Tasks Ty = 8

No consoles to display at this time.




15 Debug &2 Servers

V¥ + Daemon Thread [http-nio-8443-exec-6] (Suspended (breakpoint at line 50 in ExampleThing))
«=owns: SecureNioChannel (id=95)

ExampleThing.GetEntityCounts() line: 50

NativeMethodAccessorimpl.invokeO(Method, Object, Object[]) line: not available [native method]

= NativeMethodAccessorimpl.invoke(Object, Object]]) line: 62

= DelegatingMethodAccessorimpl.invoke(Object, Object[]) line: 43

= Method.invoke(Object, Object...) line: 497

= ReflectionProcessor.processService(Object, ValueCollection) line: 118

= ReflectionServiceHandler.processService(IServiceProvider, ValueCollection) line: 28

= ExampleThing(Thing).processServiceRequestDirect(ServiceDefinition, ValueCollection) line: 4463

ExampleThing(Thing).processAPIServiceRequest(String, ValueCollection) line: 4398

Things(BaseService).handlelnvoke(HttpExecutionContext) line: 2453

= Things(BaseService).service(HttpServletRequest, HttpServlietResponse) line: 303

= Things(HttpServlet).service(ServletRequest, ServietResponse) line: 729

= ApplicationFilterChain.internalDoFilter(ServletRequest, ServietResponse) line: 291

= ApplicationFilterChain.doFilter(ServletRequest, ServletResponse) line: 206

= WsFilter.doFilter(ServletRequest, ServietResponse, FilterChain) line: 52

= ApplicationFilterChain.internalDoFilter(ServlietRequest, ServietResponse) line: 239

ApplicationFilterChain.doFilter(ServletRequest, ServletResponse) line: 206

ContentTypeFilter.doFilter(ServietRequest, ServietResponse, FilterChain) line: 75

Debug

The Debug view displays the stack frame for the
suspended threads for each target you are debugging.




(*)= Variables 23 Breakpoints

Name Value

» @ this ExampleThil
» O result InfoTable (it
» & entityTypes String[23] (i
» U entityCounts InfoTable (it
» O platformSubsystem PlatformSut

O 1

» & entityCount InfoTable (i
» & value ValueCollec

Variaples

The Variables view displays information about the variables
associated with the stack frame selected in the Debug view.




(%)= Variables “@ Breakpoints &3

V| 2 ExampleThing [line: 50] - GetEntityCounts()

Breakpoints

The Breakpoints view lists all of the breakpoints set in the
workspace.



Step Controls

Step over

The currently-selected line to be executed
IS Invoked and suspends on the next line.

Step into

The next expression on the currently-
selected line to be executed Is invoked
and execution suspends on the next line.

Step return

Resume execution until the next return
statement In the current method and
execution suspends on the next line.

Resume

Resume the execution of suspended
threads.

B> M o RS -_-ﬁ'“?l_w] I=]

/ers

wread [http-nio-8443-exec-8] (Suspended (breakpoint at
yecureNioChannel (id=95)

eThing.GetEntityCounts() line: 50
lethodAccessorimpl.invokeO(Method, Object, Object]]) li
lethodAccessorimpl.invoke(Object, Object[]) line: 62
ingMethodAccessorimpl.invoke(Object, Object[]) line: 48
.invoke(Object, Object...) line: 497
onProcessor.processService(Object, ValueCollection) lin
onServiceHandler.processService(lServiceProvider, Valu
eThing(Thing).processServiceRequestDirect(ServiceDefir
eThing(Thing).processAPIServiceRequest(String, ValueC
BaseService).handlelnvoke(HttpExecutionContext) line: &
BaseService).service(HttpServietRequest, HitpServietRe
HttpServlet).service(ServietRequest, ServietResponse) lil
tionFilterChain.internalDoFilter(ServietRequest, ServletR
tionFilterChain.doFilter(ServietRequest, ServietResponse

r AACIH+ArICAarvidatDamiinct CarvdatDacrnAanca CiltarMhaAain)



Exercise 2

1. A'logic error exists in ExampleThing.java. Step
through the code to find it.

2. After you've |located the bug, fix it.
3. Re-build the project and import it.

4. Verity the extension works properly.



